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What's New in Sage 100

This document describes the enhancements added in Sage 100 version 2025 and 
subsequent updates. Changes to the Sage 100 Desktop are listed first, followed by global 
changes, module-specific changes, integrations, and then retired features.

Depending on your purchase agreement, some features described here may not be 
available in your product.
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What's New in Version 2025.1

What's New in Version 2025.1

The following enhancement was added in update 1 for Sage 100 2025.

Library Master

Improvement to Installed Modules Listing

The registered customer name and customer number have been added to the Installed 
Modules Listing.
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What's New in Version 2025

The following enhancements were added in Sage 100 2025.

Note: The Sage 100 2025 release features 25 suggestions from customers and 
business partners via the Sage 100 ideas site and other channels. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit 
the ideas site to share your ideas and vote for your favorites.

Your Sage 100 business partners at work! This idea was a suggestion from 
90 Minds, Inc. where “More Minds Are Better Than One.”

Sage 100 Desktop Changes
The following changes were made to the Sage 100 Desktop.

Resources Button

On the Web Content tab, the Resources button has been removed. For a one-stop shop 
to the Sage Community Hub, Knowledgebase, Product Documents page, Sage 
University, and additional services, click the Resources button on the Help tab instead.

To access file layout and program information, visit the Sage 100 Documents page and 
then select Sage 100 2025 > Administrator and Technical Documentation.
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Global Changes

Global Changes
The following changes are carried throughout multiple modules.

Option to Expand the Accounts Receivable Invoice Number

You can now expand the invoice number length from 7 to 20 characters in the Accounts 
Receivable, Sales Order, and Job Cost modules. In Common Information Options, use 
the Select the maximum length of the invoice number field to increase the length up to 
20 characters to meet your business needs.

Forms, reports, and screens are automatically changed to accommodate the expanded 
invoice number. Existing invoice numbers are not automatically converted to the new 
length.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

A/R Invoice Expansion Conversion Utility

The A/R Invoice Expansion Conversion Utility has been added to the Utilities menu. In the 
Sage 100 Desktop, select File > Run. In the Run Program window, enter *utl in the 
Program field to open the Utilities menu.

Use this utility if you want to convert your existing 7-digit numeric invoice numbers to the 
new invoice number length. Invoice numbers containing characters, or a combination of 
numerics and characters will not be changed.

Audit Tracking for Sales Orders and Purchase Orders

You now have the option to enable audit tracking for sales orders and purchase orders.  
This feature includes the following highlights:

 l In Sales Order Options and Purchase Order Options, the Changes to Track field and 
Track Additions in Detail check box have been added.

 l You can retain an audit trail of all changes, deletions, and additions.

 l When the option to track All is selected, the new Sales Order Audit Report and 
Purchase Order Audit Report are available.
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 l A Purge button on the audit report provides access to the new Purge Audit 
Report utility. You can also access the utility on the Utilities menu in each 
module.

 l In Sales Order Entry and Purchase Order Entry, click the new Audit Viewer button to 
view changes in the Audit Activity window. This feature is available if the user has 
permissions to the audit report for the module in Role Maintenance.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Copy Package Tracking Number in Accounts Receivable and Sales 
Order

In Summary Package Tracking, click the new Copy Tracking Number to Clipboard button 
to quickly copy a tracking number into an email or document.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Crystal Reports Runtime Update

The Crystal Reports Runtime 64-bit and 32-bit will be updated when installing Sage 100 
2025 server or workstation on a machine that has all current prerequisites. This update 
includes security enhancements, compatibility, performance improvements, and new 
features. 

Accounts Payable
The following change was made in the Accounts Payable module.

Switch View button in Invoice Payment Selection

The Switch View button has been added in the Select Invoices for Payment window, 
enabling you to toggle between the grid view and list view. Click the button to use the list 
view where you press CTRL + SHIFT to select invoices. Or click the button again to use 
the grid view where you use the Include check box to select invoices. The selected view 
will persist by user.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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Accounts Receivable

Accounts Receivable
The following changes were made in the Accounts Receivable module.

View Last Invoice Date and Amount Posted for Customer

The Last Invoice Date and Last Invoice Amount fields have been added on the Statistics 
tab in Customer Maintenance/Inquiry. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Print Extended Item Description

You now have the option to print the extended item description for miscellaneous items 
and charges on the following Accounts Receivable forms and their associated quick print 
tasks: Invoice Printing and Invoice History Printing.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Customer on Credit Hold Message in Cash Receipts Entry

In Cash Receipts Entry, if the selected customer is on credit hold, the "Customer on 
Credit Hold" message displays in red on the task.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Bank Reconciliation
The following changes were made in the Bank Reconciliation module.

Set Default Sort Columns by User

In the Check, Deposit and Adjustment Entry task and the Reconcile Bank task, the 
columns entered in the Sort Columns window now persist by user. This feature enables 
each user to select their own default sort columns.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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View Total Amount for Cleared Transactions

In Reconcile Bank, the Total Amount Cleared field has been added on the Checks tab 
and Dep/Adjust tab. This field displays the total for all cleared entries on each tab. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Business Insights
The following change was made in the Business Insights module.

New Views for Request for Quote

For the following primary views in Business Insights, new secondary views have been 
added for the Purchase Order Request for Quote feature.

Note: The views that are indented underneath each primary view are the 
secondary views available in the Business Insights Explore navigation pane when 
you access the primary view.

 l Purchase Order View (primary view accessed on the Business Insights Explorer 
menu or the Purchase Order Explore menu)

 l Purchase Order Quotes

 l Vendor History Quote

 l Open PO By Vendor Name View (primary view accessed on the Business Insights 
Explorer menu or the Purchase Order Explore menu)

 l Open Purchase Order Quotes

 l Vendor View (primary view accessed on the Business Insights Explorer menu or the 
Accounts Payable Explore menu)

 l Vendor History Quotes
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General Ledger

General Ledger
The following change was made in the General Ledger module.

Posting Date for Reversed Journal Entry

When using the Journal Reversal button in Account Maintenance to reverse a journal 
entry, the posting date in General Journal Entry will default to the original date of the 
entry. If the original date is in a closed period, the posting date will default to the current 
accounting date.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Inventory Management
The following changes were made in the Inventory Management module.

Option to Add Universal Product Code for an Item

On the Item Maintenance Additional tab, you can now add the Universal Product Code 
(UPC) or European Article Number (EAN) for an item. You have the flexibility to select 
from five different types of UPC or EAN codes in the UPC / EAN Type field  to meet your 
business needs.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Option to Sort by Product Line on Physical Count Reports

The ability to sort by product line has been added to the Physical Count Worksheet in the 
Sort Report By field, and in the Physical Count Variance Register and Count Card 
Variance Register in the Sort Lines By field.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Option to Print Extended Item Description on Physical Count Worksheet

The Print Extended Item Description check box has been added on the Physical Count 
Worksheet.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Print Items with Zero Balances on Trial Balance Report

The option to print inventory items where the quantity-on-hand ending balance and the 
dollar-amount-on-hand ending balance are zero has been added to the Trial Balance 
Report.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Options to Keep Window Open After Print or Preview for Inventory Labels

The Keep Window Open After Print and Keep Window Open after Preview check boxes 
have been added to Inventory Label Printing.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Inventory Requirements Planning
The following change was made in the Inventory Requirements Planning module.

View Production/Purchase Quantity Detail in IRP Inquiry and IRP Report

In Inventory Requirements Planning Inquiry, a new Production/Purchase Quantity 
column has been added to the Detail view. This saves you time from having to look up 
quantity information in the Item Detail window. The Production/Purchase Quantity detail 
now prints on the Inventory Requirements Planning Report.
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Paperless Office

Paperless Office
The following changes were made in the Paperless Office module.

Quote Document

A new Quote document has been added for the Purchase Order Request for Quote 
feature. You can define the settings and default delivery options for quotes in the 
following Paperless Office tasks.

 l Form Maintenance

 l Electronic Delivery Message Maintenance

 l Default Delivery Options

 l Vendor Viewer

 l Paperless Office Delivery Options in Vendor Maintenance/Inquiry

B/R Positive Pay Export Log Document

The B/R Positive Pay Export Log document has been added in the following Paperless 
Office tasks:

 l Journal and Register Maintenance

 l Journal and Register Viewer

 l Electronic Delivery Message Maintenance

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Form Code Name Saved in PDF Log for Customer and Vendor forms

When customer or vendor forms are sent through Paperless Office, the form code name 
is now saved in the PDF log. The Form Code field has been added in Customer Viewer 
and Vendor Viewer.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Export to Excel button Added in Viewer Tasks

The Export to Excel button has been added in all Paperless Office Viewer tasks, so you 
can export contents from list boxes to Microsoft Excel.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Production Management
The following changes were made in the Production Management module.

Standard Cost Rate per Piece Labor Improvements

In Activity Code Maintenance, you can now establish a standard cost rate per piece and  
divisor for an activity code to calculate budget labor cost. This provides you with the 
flexibility to define a standard cost rate per hour and/or rate per piece for an activity code. 
The standard cost rate per piece is the functionality that was in the Work Order module.

This feature includes the following changes in Activity Code Maintenance:

 l Standard Cost/Hour field renamed to (Standard Cost) Rate/Hour field

 l The following new fields have been added:

 l (Rate/Hour) Divisor field 

 l (Standard Cost) Rate/Piece field 

 l (Rate/Piece) Divisor field 

 Also, on the Work Ticket Transaction Entry Lines tab, the Qty Completed field has been 
added.

Work Ticket Template Maintenance Improvements

The following improvements have been made in Work Ticket Template Maintenance:

 l Revision numbers for work ticket templates are now alphanumeric instead of numeric 
only.

 l The Description field has been added next to the Revision No. field, and you can 
enter a template description when step 000000 is selected.
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Production Management

 l Next to the Step No. field, the Description field has been renamed to Step Description 
field.

 l Click the new Step Overview button to view detail step information.

 l Attachments are now specific to a work ticket step instead of the entire work ticket 
template.

 l When you click Cancel, the following key fields are now available: Template No. and 
Revision No. This improvement reduces the number of clicks necessary to access 
each key field.

 l To make the budgeting of a step more intuitive, the Calculate Budget check box has 
been added on the Work Ticket Template Maintenance Additional tab. Select this 
check box to recalculate budget values using the information from the activity code 
assigned to the step. When the check box is selected, the following fields can only be 
viewed: Setup Hours, Hours, Labor Cost, and Material Cost.

Copy From Step

In Work Ticket Template Maintenance, the Copy From feature has been enhanced. You 
can now copy a specific step from a work ticket template, or an open or closed work 
ticket. The Copy From button is available when any step is selected.

You can also use this feature to renumber a step in a new template that has not been 
used yet. 

Option to Relieve WIP on Last Completion

On the Production Management Options Entry tab, the Relieve WIP on Last Completion 
check box has been added. Select it to post remaining WIP to the inventory account when 
the work ticket is completed.

Enhanced Scheduling to Calculate Budgets

When the Enhanced Scheduling feature is enabled, labor budget hours in Work Ticket 
Entry are now based on the same calculated hours used for Enhanced Scheduling.
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Purchase Order
The following changes were made in the Purchase Order module.

Option to Require Cancellation Code When Deleting Order/Quote

On the Purchase Order Options History tab, the Cancel/Reason Code Required When 
Deleting Orders/Quotes check box has been added. Select this check box to require the 
entry of a cancellation code when a purchase order/quote or  line is deleted.

In addition, if Yes or Prompt is selected at the Retain Deleted Orders/Quotes or Retain 
Deleted Lines for Orders/Quotes field and you delete a purchase order/quote or line, the 
Cancellation Code window will automatically appear.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Reverse Work Ticket Cost and Quantities in Return of Goods

If the Production Management module is integrated with Purchase Order and if a 
purchase order is costed to a work ticket, you can now reverse the appropriate work ticket 
cost and quantities from the Work Ticket files. 

On the Return of Goods Entry Lines tab, the following fields have been added: Work 
Ticket No., W/T Desc, Step No., and Step Desc. Use these fields to modify the work ticket 
distribution information for line items on the original purchase order. You can also enter 
work ticket distribution information for returns for which there is no corresponding 
purchase order.

Request for Quote

In Purchase Order Entry, you can now enter a quote and email a Request for Quote to 
one or multiple vendors using Paperless Office to find the lowest cost for purchased 
materials.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Changes in Purchase Order Entry

The following features have been added in Purchase Order Entry for quotes:
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Purchase Order

 l On the Header tab, a new Quote option has been added in the Order Type field.

 l When entering a quote, you have the option to determine the unit cost to use for 
items based on the Select Unit Cost for Quote field in Purchase Order Options. 

 l When using the Copy From feature, you can copy existing quotes.

 l Quotes sent to vendors are created using the vendor's alias item numbers.

 l Click Generate Order to generate a purchase order from a quote. This feature is 
available based on a security option.

 l Click the new drop-down button next to the Print button to select Purchase 
Order Printing or Quote Printing.

New Tasks on the Purchase Order Main Menu

The following new tasks have been added for quotes:

 l Auto Generate Orders from Quotes

 l Quote Printing

Option to Print Quotes on Reports

The option to print quotes has been added and the Completed status now applies to 
quotes on the following reports:

 l Open Purchase Order Report

 l You can also print quotes on hold. In the selection grid, the 
Required/Expire Date column applies to quotes now.

 l Open Orders by Item Report

 l Open Orders by Job Report

 l Purchase Order Recap

 l Purchase Order History Report

 l You can also print canceled quotes. 

Changes in Purchase Order Options

On the Entry tab, the following options have been added for quotes:

 l Use Default Order Date When Generating Purchase Order

 l Default Days Until Quote Expires

 l Select Unit Cost for Quote

Sage 100 What's New Guide 14



The following fields have been renamed to include quotes:

 l On the Main tab: Days to Retain Completed Purchase Orders/Quotes field

 l On the History tab:

 l Retain Purchase Order/Quote History field

 l Retain Deleted Orders/Quotes field

 l Retain Deleted Lines for Orders/Quotes field

Changes on the Purchase Order Utilities Menu

The following tasks have been renamed to include quotes:

 l Purge Completed Purchase Orders/Quotes

 l Purge Exp Quotes/Master/Repeating Orders

The Create Purchase Order History utility now includes quotes when creating records in 
the Purchase Order History files.

Other Changes

The following changes have been made in other modules for quotes:

 l In Accounts Payable, quotes display on the Vendor Maintenance P/Os tab and you 
can search for quotes in the Search for Purchase Orders window. 

 l In Inventory Management, quotes display on the Item Maintenance Orders tab and 
you can search for quotes in the Search for Purchase Orders window.

Option to Not Back Order Purchase Order When Returning Item

On the Return of Goods Entry Header tab and Lines tab, the Back Order PO check box 
has been added. If a returned item is no longer needed, clear this check box so that a 
back order will not be created for the returned item on the purchase order. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Sales Order

Sales Order
The following changes were made in the Sales Order module.

Customer Telephone on Sales Order Invoices

The customer telephone number has been added on the Header tab of the following 
tasks:

 l Sales Order Entry 

 l S/O Invoice Data Entry

 l Sales Order and Quote History Inquiry

 l A/R Invoice History Inquiry for sales order invoices

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Require Cancellation Code When Deleting Order/Quote

On the Sales Order Options History tab, the Cancel/Reason Code Required When 
Deleting Orders/Quotes check box has been added. Select this check box to require the 
entry of a cancellation code when a sales order/quote or line is deleted.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Print Extended Item Description

You now have the option to print the extended item description for regular items, 
miscellaneous items, charges, and special items on the following Sales Order forms and 
their associated quick print tasks: 

 l Sales Order Printing 

 l Picking Sheet Printing 

 l Invoice Printing 

 l Packing List Printing 

 l Additional Packing List Printing 

 l Sales Order and Quote History Printing 
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 l Bar Code Sales Order Printing 

 l Bar Code S/O Picking Sheet

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Visual Integrator
The following change was made in the Visual Integrator module.

Enter a Descriptive Name for Temp Fields

In Import Job Maintenance and Export Job Maintenance, you can now enter a descriptive 
name for temporary fields. On the Data tab, click the Add Temp Field button and in the 
new Temp Field window, enter a name of up to 20 characters.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Visual Process Flows
The following change was made in the Visual Process Flows module.

Request for Quote Process Flow

On the Visual Process Flows Purchases menu, the Request for Quote process flow has 
been added. Use this process flow to create quotes for purchase orders, print or email 
quotes for one or more vendors, and generate purchase orders.
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Integrations

Integrations
The following integrations are available in Sage 100 2025.

Sage Supply Chain Intelligence (SSCI) Integration – Available Fall 2025

Integrate Sage 100 with Sage Supply Chain Intelligence (formerly known as Anvyl) for 
powerful purchase order management.  SSCI bridges the gap between issuance of a 
purchase order and receipt of goods, providing a cloud-based way to collaborate with 
suppliers, consolidate shipments, create custom P/O workflows, and even create and edit 
purchase orders, and have the data flow back into Sage 100.

Use the Sage Supply Chain Intelligence Setup app to perform integration for Sage 100 
2025, 2024.2, and 2023.5.

For instructions, see Set Up Sage Supply Chain Intelligence (Anvyl) Integration in 
Sage 100 help.

Sage Intelligence Reporting Version 8.0

Sage Intelligence Reporting version 8.0 is now available with the Sage 100 2025 release.

Retired Features
The following features are no longer available in Sage 100 version 2025.

Microsoft 365 Connector and Office 365 Contacts

The Microsoft 365 Connector and Office 365 Contacts are now retired in Sage 100 
version 2025. The interface to bring customers onto the Connector was deprecated by 
Microsoft in April 2024, and these add-ons are no longer available in version 2025.

SData Security 

In Role Maintenance, the SData Security tab has been removed for both subscription and 
non-subscription versions of Sage 100.

In System Configuration, the Enable Native SData Provider and Access within Role 
Maintenance check box has been removed.
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With the retirement of SData Security, the option to install the Native SData Provider 
Adapter has been removed from the  Productivity Applications screen (accessed from the 
Sage 100 Autorun.exe).

Vault-Only Accounts

On August 1, 2024, Nuvei/Paya discontinued the creation of vault-only accounts to 
improve security and payment card industry (PCI) compliance. A vault-only account is an 
account used to store the last 4 digits of a credit card; it cannot be used to process credit 
card transactions. 

In Sage 100 2025, vault-only accounts are no longer automatically created. You must 
have a Nuvei/Paya merchant account to add credit cards for new customers. Also, the 
following changes have been made:

 l In A/R Payment Type Maintenance, if you remove the virtual terminal ID and 
merchant key for a credit card payment type and click Accept, a message will appear 
to notify you that credit card records will be disconnected from Nuvei/Paya. At this 
message, you can click Yes to disconnect the credit card record from Nuvei/Paya, or 
click No to return to Payment Type Maintenance and enter a virtual terminal ID and 
merchant key.

 l When adding a credit card on-the-fly in an Accounts Receivable or Sales Order data 
entry task, a virtual terminal ID and merchant key must be defined for the credit card 
payment type in Payment Type Maintenance or Company Maintenance to save the 
credit card record.

 l When copying a company in Company Maintenance, the source company's virtual 
terminal ID and merchant key for credit card payment types are not copied to the 
destination company.
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